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Revision History
1. Rev. 1.0: Initial release.
2. Rev. 1.1: Most modifications are made to reflect functional changes on the user interface.
* Modified the description for the expandable/Collapsible functional menus.
* Added the Recording to SD/SDHC details. (SD local storage is now available on VS8401)
* Added Local Storage options.
* Added the Quad View setting options.
* Added the joystick configuration options.
3. Rev. 1.2: Added description for VS8801 stating that it does not support the SD card local storage.
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Overview
VIVOTEK VS8801/8401, the new milestone in video server security performing 8-CH or 4-CH high
resolution with high frame rate in H.264, are able to convert analog video into digital video with the
highest quality. The H.264 compression format drastically reduces the file sizes and conserves
valuable bandwidth and storage space. The VS8401 supports simultaneous dual streams, while the
VS8801 supports single stream to be transmitted in H.264, MPEG-4 and MJPEG formats for versatile
applications. The stream
can also be individually configured with frame rates, resolution, and image quality so as to meet different
platforms or bandwidth constraints.
Featured with intelligent video functions, such as motion detection & tamper detection, the VS8801/8401
are capable of upgrading analog cameras into intelligent cameras. The tamper detection feature can
detect events such as blockage, redirection, defocus, and spray-painting of camera lens, making it an
intelligent solution to possible camera obstruction. Furthermore, the video server also upgrades the
security level of the IP surveillance system with the network security protocols, HTTPS and 802.1x. It is
also designed with Giga LAN for large transmission need and DC 12V / AC 24V compatible power input
design. These features make VS8801/8401 easy to install and integrate with the existing analog system.
Monitoring with VIVOTEK’s ST7501 as the video management software for better scalability and easyto-use operation is another delightful benefit. Most importantly, it is designed for rack mount solution for
easy installation. The solution for video server is a pioneering idea in the world. The innovative vision of
video server, VS8801/8401, help you easily upgrade to a full-featured, high-end IP surveillance solution!

Read Before Use

The use of surveillance devices may be prohibited by law in your country. The video server is not only
a high-performance web-ready camera but can also be part of a flexible surveillance system. It is the
user’s responsibility to ensure that the operation of such devices is legal before installing this unit for its
intended use.
It is important to first verify that all contents received are complete according to the Package Contents
listed below. Take note of the warnings in the Quick Installation Guide before the video server is installed;
then carefully read and follow the instructions in the Installation chapter to avoid damage due to faulty
assembly and installation. This also ensures the product is used properly as intended.
The video server is a network device and its use should be straightforward for those who have basic
networking knowledge. It is designed for various applications including video sharing, general security/
surveillance, etc. The Configuration chapter suggests ways to best utilize the video server and ensure
proper operations. For creative and professional developers, the URL Commands of the video server
section serves as a helpful reference to customizing existing homepages or integrating with the current
web server.

Package Contents
■ VS8801/8401
■ Power Adapter
■ Software CD
■ Warranty Card
■ Quick Installation Guide
■ Terminal blocks
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Physical Description
Front Panel
■ VS8801
BNC Video Input
RCA Audio Input

■ VS8401
USB & SD card
functions
are not available
on this unit.

BNC Video Input

USB function
is not available
on this unit.

RCA Audio Input

Back Panel
■ VS8801
USB & SD card
functions
are not available
on this unit.

Ethernet 10/100/1000
RJ45 Socket

Power Cord
Socket

Click this button before removing the flash drive
USB function
is not available
on this unit.

Status LEDs
USB Socket
General I/O
Terminal Block

USB & SD card
functions
are not available
on this unit.

Not used

Recessed Reset Button

■ VS8401
Ethernet 10/100/1000
RJ45 Socket

USB & SD card
functions
are not available
on this unit.

Power Cord
Socket
Recessed Reset Button

NOTE:

Click this button before removing the flash drive

Status LEDs
USB Socket
General I/O
Terminal Block

USB function
is not available
on this unit.

SD/SDHC Card Slot
Click this button before removing the SD/SDHC card

The USB socket is for maintenance purposes only.
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General I/O Terminal Block
This video server provides a general I/O terminal block which is used to connect external input /
output devices. The pin definitions are described below.

■ VS8801

USB & SD card
functions
are not available
on this unit.

USB function
is not available
on this unit.

CH 8
GND

CH 8
DI

CH 7
GND

CH 7
DI

CH 6
GND

CH 6
DI

CH 5
GND

CH 5
DI

CH 4
GND

CH 4
DI

CH 3
GND

CH 3
DI

CH 2
GND

CH 2
DI

CH 1
GND

CH 1
DI

CH 8
GND

CH 8
DO

CH 7
GND

CH 7
DO

CH 6
GND

CH 6
DO

CH 5
GND

CH 5
DO

CH 4
GND

CH 4
DO

CH 3
GND

CH 3
DO

CH 2
GND

CH 2
DO

CH 1
GND

CH 1
DO

GND

GND

CH 8
Audio
out

CH 7
Audio
out

CH 6
Audio
out

CH 5
Audio
out

CH 4
Audio
out

CH 3
Audio
out

CH 2
Audio
out

CH 1
Audio
out

RS
485-

RS
485+

24V
AC

24V
AC

GND

DC
12V

■ VS8401

USB & SD card
functions
are not available
on this unit.

USB function
is not available
on this unit.

GND

N/A

CH 4
GND

CH 4
DI

CH 3
GND

CH 3
DI

CH 2
GND

CH 2
DI

CH 1
GND

CH 1
DI

GND

N/A

CH 4
GND

CH 4
DO

CH 3
GND

CH 3
DO

CH 2
GND

CH 2
DO

CH 1
GND

CH 1
DO

CH 4
Audio
out

CH 3
Audio
out

CH 2
Audio
out

CH 1
Audio
out

RS
485-

RS
485+

24V
AC

24V
AC

GND

DC
12V
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DI/DO Diagram
Please refer to the following illustration for the connection method.

Sensors/detectors

GND

Digital Inputs

Digital Outputs

USB function
is not available
on this unit.

Alarms

GND

DC Power

Power Source

NOTE:
► External alarms or other devices that connect to the digital outputs require external power supply, e.g.,
DC power from a power adapter.
► 12V Ground should connect to Video Server ground termail block. For detailed pin definition,
please refer to page 7.
► It is recommended to keep the current running through each of the DO lines under 1A.

Status LED

The LED indicates the status of the video server. The table below shows the statuses of the
Yellow (SD), Green (Network), and Red (Power) LEDs.
LED
Name
SD
Network
Power

Item LED status
1

Steady Yellow

2

Blinking Yellow

3
1
2
1
2

LED Off
Blinking Green every 1 sec.
Green LED Off
Steady Red
Red LED Off
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Description
SD card is present and functioning normally
SD card is present yet problems occurred with
data access
No SD card in the socket
Network activity (heartbeat)
Network failed
Power on and during system boot
Power off

VIVOTEK

Below are the definitions for other combinations of LEDs:
Item LED status
Description
1 Blinking Green every 2 sec.
Audio mute (heartbeat)
Blinking Red every 0.15 sec. + Blinking Green every
2
Upgrading Firmware
1 sec.
Blinking Red every 0.15 sec. + Blinking Green every
3
Restoring default
0.15 sec.

Hardware Reset

■ VS8801

USB & SD card
functions
are not available
on this unit.

USB function
is not available
on this unit.

Recessed Reset Button

■ VS8401

USB & SD card
functions
are not available
on this unit.

USB function
is not available
on this unit.

Recessed Reset Button

The reset button is used to reset the system or restore the factory default settings. Sometimes
resetting the system can return the video server to normal operation. If the system problems
remain after reset, restore the factory settings and install again.
Reset: Press and release the recessed reset button using a straightened paper clip. Wait for the
video server to reboot.
Restore: Press and hold the reset button down until the status LED rapidly blinks. It takes about
30 seconds. Note that all settings will be restored to factory default. Upon successful restore,
the status LED will blink green and red during normal operation.
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Network Deployment
Setting up the Video Server over the Internet
This section explains how to configure the video server to an Internet connection.
1. Make video connection from the camera to the BNC video input.
2. Make audio connection from the Line-Out audio source to the RCA audio input.

Analog Camera

CAMERA NO.

1 2 3

MIC

POWER
OFF

ON

OUT

VIDEO

IN

OUT

1
2

3. Connect the Video Server to a switch via Ethernet cable.
4. Connect the power cable from the Video Server to a power outlet.
5. If you have external devices such as sensors and alarms, connect them to the general I/O
terminal block. For detailed pin definition, please refer to the next page.

5
4

3

GbE Ethernet Switch

POWER

COLLISION

1

2

3

4

5

LINK
RECEIVE
PARTITION

There are several ways to set up the video server over the Internet. The first way is to set up
the video server behind a router. The second way is to utilize a static IP. The third way is to use
PPPoE.
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Internet connection via a router
Before setting up the video server over the Internet, make sure you have a router and follow the
steps below.
1. Connect your video server behind a router, the Internet environment is illustrated below.
Regarding how to obtain your IP address, please refer to Software Installation on page 12 for
details.

WAN (Wide Area Network )

Internet

Router IP address : from ISP
POWER

COLLISION

1

2

3

4

5

IP address : 192.168.0.3
Subnet mask : 255.255.255.0
Default router : 192.168.0.1

LINK
RECEIVE
PARTITION

LAN (Local Area Network)
Router IP address : 192.168.0.1
Cable or DSL Modem

IP address : 192.168.0.2
Subnet mask : 255.255.255.0
Default router : 192.168.0.1

2. In this case, if the Local Area Network (LAN) IP address of your Video server is
192.168.0.3, please forward the following ports for the Video server on the router.
■ HTTP port
■ RTSP port
■ RTP port for audio
■ RTCP port for audio
■ RTP port for video
■ RTCP port for video
If you have changed the port numbers on the Network page, please open the ports accordingly
on your router. For information on how to forward ports on the router, please refer to your
router’s user’s manual.
3. Find out the public IP address of your router provided by your ISP (Internet Service Provider).
Use the public IP and the secondary HTTP port to access the Video server from the
Internet. Please refer to Network Type on page 35 for details.
Internet connection with static IP
Choose this connection type if you are required to use a static IP for the Video server. Please
refer to LAN on page 35 for details.
Internet connection via PPPoE (Point-to-Point over Ethernet)
Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to
PPPoE on page 36 for details.
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Software Installation
Installation Wizard 2 (IW2), free-bundled software included on the product CD, helps you set up
your video server on the LAN.
IW2

1. Install IW2 under the Software Utility directory from the software CD.
Double click the IW2 shortcut on your desktop to launch the program.

Installation
Wizard 2

2. The program will conduct an analysis of your network environment.
After your network environment is analyzed, please click Next to continue the program.

3. The program will search for all VIVOTEK network devices on the same LAN.
4. After a brief search, the main installer window will prompt. Double-click on the MAC and
model name which matches the product label on your device to connect to the Network
Camera via a web browser.

Video Server
Model No: VS8801
xxxxx

MAC:0002D1730202
Class A

R o HS
00-02-D1-73-02-02
Made in Taiwan
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0002D1730202

192.168.5.151

VS8801
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Ready to Use
1. A browser session with the Video Server should prompt as shown below.
2. You should be able to see live video from your camera. You may also install the 32-channel
recording software from the software CD in a deployment consisting of multiple cameras. For
its installation details, please refer to its related documents.
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Accessing the Video Server
This chapter explains how to access the video server through web browsers, RTSP players,
3GPP-compatible mobile devices, and VIVOTEK recording software.

Using Web Browsers
Use Installation Wizard 2 (IW2) to access to the video servers on the LAN.
If your network environment is not a LAN, follow these steps to access the Netwotk Camera:
1. Launch your web browser (ex. Microsoft® Internet Explorer, Mozilla Firefox, or Netscape).
2. Enter the IP address of the video server in the address field. Press Enter.
3. The live video will be displayed in your web browser.
4. If it is the first time installing the VIVOTEK video server, an information bar will pop up as
shown below. Follow the instructions to install the required plug-ins on your computer.

NOTE:

► By default, the video server is not password-protected. To prevent unauthorized access, it is
highly recommended to set a password for the video server. For more information about how
to enable password protection, please refer to Security on page 28.
► If you see a dialog box indicating that your security
settings prohibit running ActiveX® Controls, please
enable the ActiveX® Controls for your browser.
1. Choose Tools > Internet Options > Security
> Custom Level.
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2. Look for Download signed ActiveX ® controls; select Enable or Prompt. Click OK.

3. Refresh your web browser, then install the Active X ® control. Follow the instructions to
complete installation.
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Using RTSP Players
To view the MPEG-4 streaming media using RTSP players, you can use one of the following
players that support RTSP streaming.
Quick Time Player
Real Player
VLC media player
1. Launch the RTSP player.
mpegable
Player
2. Choose
File > Open
URL. A URL dialog box will pop up.
3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for
pvPlayer
stream1 or stream2>
As most ISPs and players only allow RTSP streaming through port number 554, please set the
RTSP port to 554. For more information, please refer to RTSP Streaming on page 48.
For example:
rtsp://192.168.5.151:554/live.sdp

4. The live video will be displayed in your player.
For more information on how to configure the RTSP access name, please refer to RTSP
Streaming on page 48 for details.
Video 16:38:01 2011/03/10
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Using 3GPP-compatible Mobile Devices
To view the streaming media through 3GPP-compatible mobile devices, make sure the video
server can be accessed over the Internet. For more information on how to set up the video
server over the Internet, please refer to Setup the video server over the Internet on page 10.
To utilize this feature, please check the following settings on your video server:
1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page 48.
2. As the the bandwidth on 3G networks is limited, you will not be able to use a large video size.
Please set the video and audio streaming parameters as listed below.
Video Mode
Frame size
Maximum frame rate
Intra frame period
Video quality (Constant bit rate)
Audio type (G.711)

MPEG-4
QCIF
5 fps
1S
40kbps
64kbps

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page 48.
4. Launch the player on the 3GPP-compatible mobile devices (ex. Real Player).
5. Type the following URL commands into the player.
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming
access name for stream 3>.
For example:
rtsp://192.168.5.151:554/live.sdp
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Using VIVOTEK Recording Software
The product software CD also contains recording software, allowing simultaneous monitoring
and video recording for multiple video servers. Please install the recording software; then launch
the program to add the video server to the Channel list. For detailed information about how to
use the recording software, please refer to the user’s manual of the software or download it from
http://www.vivotek.com.
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Main Page
This chapter explains the layout of the main page. It is composed of the following sections:
VIVOTEK INC. Logo, Host Name, Camera Control Area, Configuration Area, Menu, and
Live Video Window. The Manual Trigger and Digital Input/Digital Output control menus are
expandable and collapsible, while the PTZ navigation panel is available only when a PTZ
camera is attached.

VIVOTEK INC. Logo

Host Name

Camera Control Area

Live View Window
Manual Trigger Area

DI/O Control Area

Configuration Area

VIVOTEK INC. Logo
Click this logo to visit the VIVOTEK website.

Host Name

The host name can be customized to fit your needs. For more information, please refer to System settings
on page 26.

Camera Control Area
Video Stream: VS8401 supports 4 channels for video live viewing, as VS8801 supports 8 channels. Each
channel allows you to view only one stream. There are channel1,2,3,4,(5,6,7,8),and Quad View for you
to choose. For more information about video settings, please refer to page 56 for detailed information.
PTZ Control Area: The up/down/left/right/zoom/focus/pan buttons allow
you to adjust the video in the viewing window to the spot you wish
to watch.
Home button allows you to resume the center of the
screen. Click Patrol to move from one point to another; click it again to
stop patroling. Click Stop to stop the pan movement. Please refer to
Configuration > Camera Control on page 68 for more information.
Pan/Tilt/Zoom Speed: In the drop-down list, the speed ranges from
-5~5 (slow/fast).
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Manual Trigger Area

Click to enable/disable an event trigger manually. Please configure an event setting on Application page
before enable this function. A total of 4 event settings can be configured. For more information about
event settings, please refer to page 79.
If you want to hide this item on the homepage, please go to the Homepage layout page to uncheck “show
manual trigger button”. Please refer to page 75 for detail.

DI/O Control Area

Digital output: There are 4 (VS8401) or 8 (VS8801) digital output switches; click to turn the digital output
device on or off. Switch 1 is for channel 1 digital output control, switch 2 is for channel 2 digital output
control, and so on.
Digital input: There are 4 (VS8401) or 8 (VS8801) digital input status indicators. A Red indicator shows
the digital input status is active, while the white indicator shows inactive.

Configuration Area
Client Settings: Click this button to access the client setting page. For more information, please refer to
Client Settings on page 22.
Configuration: Click this button to access the configuration page of the video server. It is suggested that
a password be applied to the video server so that only the administrator can configure the video server.
For more information, please refer to Configuration on page 25.
Language: Click this button to choose a language for the user interface. Language options are available
in: English, Deutsch, Español, Français, Italiano, 日本語, Português, 簡体中文, and 繁體中文.

Live Video Window

MPEG-4 Protocol and Media Options

Video Title
Title and Time

Video (UDP-AV)

Time

Video 14:46:09 2011/01/19

Video and Audio Control Buttons

Video Title: The video title can be configured. For more information, please refer to Video settings on
page 56.
MPEG-4 Protocol and Media Options: The transmission protocol and media options for MPEG-4 video
streaming. For further configuration, please refer to Client settings on page 22.
Time: Display the current time. For further configuration, please refer to Video settings on page 56.
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Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Video settings on page 56.
Video and Audio Control Buttons: Depending on the video server model and video server configuration,
some buttons may not be available.
Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.
Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen.

Pause: Pause the transmission of the streaming media. The button becomes the
after clicking the Pause button.
Stop: Stop the transmission of the streaming media. Click the
transmission.

Resume button

Resume button to continue

Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.
Stop MP4 Recording button to end recording. When you exit the web browser, video
Press the
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 saving
options on page 23 for details.
Volume: When the
local computer.

Mute function is not activated, move the slider bar to adjust the volume on the

Mute: Turn off the volume on the local computer. The button becomes the
clicking the Mute button.

Audio On button after

Talk: Click this button to talk to people around the video server. Audio will project from the external
again to end talking transmission.
speaker connected to the video server. Click this button
Broadcast: Click this button to broadcast to all channels.
Mic Volume: When the
Mute function is not activated, move the slider bar to adjust the
microphone volume on the local computer.
Mute: Turn off the
Mic volume on the local computer. The button becomes the
after clicking the Mute button.

Mic On button

Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.
Go to: The drop-down menu enables you to locate and move to a preset location instantly on the viewing
window.
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Client settings
This chapter explains how to select the stream transmission mode and saving options on the
local computer. When completed with the settings on this page, click Save on the page bottom
to enable the settings.
H.264 / MPEG-4 media options

Select to stream video or audio data or both. This is enabled only when the video mode is set to H.264 or
MPEG-4.

H.264 / MPEG-4 protocol options

Depending on your network environment, there are four transmission modes of H.264 or MPEG-4
streaming:
UDP unicast: This protocol allows for more real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the video server allows up to
ten simultaneous accesses.
UDP multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the video server
while serving multiple clients at the same time. Note that to utilize this feature, the video server must be
configured to enable multicast streaming at the same time. For more information, please refer to RTSP
Streaming on page 48.
TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. The downside of this protocol is that its real-time effect is not as good as that of the UDP protocol.
HTTP: This protocol allows the same quality as TCP protocol without needing to open specific ports for
streaming under some network environments. Users inside a firewall can utilize this protocol to allow
streaming data through.
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MP4 saving options

Users can record live video as they are watching it by clicking
page. Here, you can specify the storage destination and file name.

Start MP4 Recording on the main

Folder: Specify a storage destination for the recorded video files.
File name prefix: Enter the text that will be appended to the front of the video file name.
Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name.
CLIP_20110114-180853

File name preﬁx Date and time sufﬁx
The format is: YYYYMMDD_HHMMSS

Quadview settings

Here is where you configure which video streams will be displayed in the Quad View window.
The default is the stream 2 with a lower resolution.

Local Streaming Buffer Time

Due to the unsteady bandwidth flow, the live streaming may lag and not be very smoothly. If you enable
this option, the live streaming will be stored on the camera’s buffer area for a few seconds before playing
on the live viewing window. This will help you see the streaming more smoothly. If you enter 3000
Millisecond, the streaming will delay 3 seconds.
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Joystick settings

Calibrate: Make sure a joystick is already attached to your COM port or USB port on your client
computer. Click on the Calibrate button and the Windows Game Controller function will be started.
If properly connected, your operating system should have already detected the joystick. Follow the
onscreen instructions to calibrate your joystick.

Configure buttons: You can define individual joystick buttons using this function. Click to open a
configuration window and assign functions to joystick buttons using the following steps: 1. Select a
button uing the pull-down menu. 2. Select an Action to be toggled by the button. 3. Click on the Assign
button, and then repeat the process to define other buttons.

1
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Configuration
Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.
VIVOTEK offers an easy-to-use user interface that helps you set up your video server with
minimal effort. To simplify the setting procedure, two types of user interfaces are available:
Advanced Mode for professional users and Basic Mode for entry-level users. Some advanced
functions (HTTPS/ SNMP/ Access list/ Homepage layout/ Application/ System log/ View
parameters) are not displayed in Basic Mode.
If you want to set up advanced functions, please click [Advanced mode] on the bottom of the
configuration list to quickly switch to Advanced Mode.
In order to simplify the user interface, the detailed information will be hidden unless you click on
the function item. When you click on the first sub-item, the detailed information for the first subitem will be displayed; when you click on the second sub-item, the detailed information for the
second sub-item will be displayed and that of the first sub-item will be hidden.
The following is the interface of the Basic mode and the Advanced mode:
Basic mode

Configuration List

Click to switch to Advanced Mode
Firmware Version
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Advanced mode

Configuration List

Click to switch to Basic Mode
Firmware Version

Each function on the configuration list will be explained in the following sections. Those functions that are
displayed only in Advanced Mode are marked with Advanced mode . If you want to set up advanced
functions, please click [Advanced Mode] at the bottom of the configuration list to quickly switch over.

System
This section explains how to configure the basic settings for the video server, such as the host
name and system time. It is composed of the following three columns: System, System Time
and DI and DO. When finished with the settings on this page, click Save at the bottom of the
page to enable the settings.
System

Host name: Enter a desired name for the video server. The text will be displayed at the top of the main
page.
Turn off the LED indicators: If you do not want to let others know that the video server is in operation, you
can select this option to turn off the LED indicators.
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System time

Keep current date and time: Select this option to preserve the current date and time of the Video server.
The video server’s internal real-time clock maintains the date and time even when the power of the
system is turned off.
Sync with computer time: Select this option to synchronize the date and time of the video server with the
local computer. The read-only date and time of the PC is displayed as updated.
Manual: The administrator can enter the date and time manually. Note that the date and time format are
[yyyy/mm/dd] and [hh:mm:ss].
Automatic: The Network Time Protocol is a protocol which synchronizes computer clocks by periodically
querying an NTP Server.
NTP server: Assign the IP address or domain name of the time-server. Leaving the text box blank
connects the video server to the default time servers.
Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly
basis.
Time zone Advanced Mode : Select the appropriate time zone from the list. If you want to upload
Daylight Savings Time rules on the Maintenance page, please refer to Upload / Export daylight saving
time configuration file on page 102 for details.
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Security
This section explains how to enable password protection and create multiple accounts.
Root password

The administrator account name is “root”, which is permanent and can not be deleted. If you want to add
more accounts in the Manage User column, please apply the password for the “root” account first.
1. Type the password identically in both text boxes, then click Save to enable password protection.
2. A window will be prompted for authentication; type the correct user’s name and password in their
respective fields to access the video server.

Manage privilege Advanced Mode

Digital Output & PTZ control: You can modify the manage privilege of operators or viewers. Check or
uncheck the item, then click Save to enable the settings. If you give Viewers the privilege, Operators will
also have the ability to control the video server through the main page. (Please refer to Main Page on
page 19.)
Allow anonymous viewing: If you check this item, any client can access the live stream without entering a
User ID and Password.

Manage user

Administrators can add up to 20 user accounts.
1. Input the new user’s name and password.
2. Select the privilege level for the new user account. Click Add to enable the setting.
Access rights are sorted by user privilege (Administrator, Operator, and Viewer). Only administrators can
access the Configuration page. Though operators cannot access the Configuration page, they can use
the URL Commands to get and set the value of parameters. For more information, please refer to URL
Commands of the video server on page 105. Viewers access only the main page for live viewing.
Here you also can change a user’s access rights or delete user accounts.
1. Select an existing account to modify.
2. Make necessary changes and click Update or Delete to enable the setting.
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HTTPS (Hypertext Transfer Protocol over SSL)

Advanced Mode

This section explains how to enable authentication and encrypted communication over SSL
(Secure Socket Layer). It helps protect streaming data transmission over the Internet on higher
security level.
Enable HTTPS

Check this item to enable HTTPS communication, then select a connection option: "HTTP & HTTPS"
or "HTTPS only". Note that you have to create and install a certificate first in the second column before
clicking the Save button.

Create and install certificate method
Before using HTTPS for communication with the video server, a Certificate must be created first. There
are three ways to create and install a certificate:
Create self-signed certificate automatically
1. Select this option.
2. In the first column, check Enable HTTPS secure connection, then select a connection option: “HTTP
& HTTPS” or “HTTPS only”.
3. Click Save to generate a certificate.
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4. The Certificate Information will automatically de displayed in the third column as shown below. You can
click Property to view detailed information about the certificate.

5. Click Home to return to the main page. Change the address from “http://” to “https://“ in the address
bar and press Enter on your keyboard. Some Security Alert dialogs will pop up. Click OK or Yes to
enable HTTPS.

https://

https://192.168.5.151/index.html
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Create self-signed certificate manually
1. Select this option.
2. Click Create to open the Create Certificate page, then click Save to generate the certificate.

3. The Certificate Information will automatically be displayed in the third column as shown below. You
can click Property to see detailed information about the certificate.

Create certificate and install : Select this option if you want to create a certificate from a certificate
authority.
1. Select this option.
2. Click Create to open the Create Certificate page, then click Save to generate the certificate.
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3. If you see the following Information bar, click OK and click on the Information bar at the top of the page
to allow pop-ups.

4. The pop-up window shows an example of a certificate request.
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5. Look for a trusted certificate authority that issues digital certificates. Enroll the video server. Wait for
the certificate authority to issue a SSL certificate; click Browse... to search for the issued certificate,
then click Upload in the second column.

NOTE:
► How do I cancel the HTTPS settings?
1. Uncheck Enable HTTPS secure connection in the first column and click Save; a warning dialog
will pop up.
2. Click OK to disable HTTPS.

3. The webpage will redirect to a non-HTTPS page automatically.
► If you want to create and install other certificates, please remove the existing one. To remove the
signed certificate, uncheck Enable HTTPS secure connection in the first column and click Save.
Then click Remove to erase the certificate.
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SNMP (Simple Network Management Protocol)

Advanced Mode

This section explains how to use the SNMP on the video server. The Simple Network
Management Protocol is an application layer protocol that facilitates the exchange of
management information between network devices. It helps network administrators to remotely
manage network devices and find, solve network problems with ease.
■ The SNMP consists of the following three key components:
1. Manager: Network-management station (NMS), a server which executes applications that monitor and
control managed devices.
2. Agent: A network-management software module on a managed device which transfers the status of
managed devices to the NMS.
3. Managed device: A network node on a managed network. For example: routers, switches, bridges,
hubs, computer hosts, printers, IP telephones, video servers, web server, and database.
Before configuring SNMP settings on the this page, please enable your NMS first.

SNMP Configuration
Enable SNMPv1, SNMPv2c
Select this option and enter the names of Read/Write community and Read Only community according to
your NMS settings.

Enable SNMPv3
This option contains cryptographic security, a higher security level, which allows you to set the
Authentication password and the Encryption password.
■ Security name: According to your NMS settings, choose Read/Write or Read Only and enter the
community name.
■ Authentication type: Select MD5 or SHA as the authentication method.
■ Authentication password: Enter the password for authenrication (at least 8 characters).
■ Encryption password: Enter a password for ecryption (at least 8 characters).
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Network
This section explains how to configure a wired network connection for the video server.
Network type

LAN

Select this option when the video server is deployed on a local area network (LAN) and is intended to be
accessed by local computers. The default setting for the Network Type is LAN. Rememer to click Save
when you complete the Network setting.
Get IP address automatically: Select this option to obtain an available dynamic IP address assigned by
the DHCP server each time the camera is connected to the LAN.
Use fixed IP address: Select this option to manually assign a static IP address to the video server.

1. You can make use of VIVOTEK Installation Wizard 2 on the software CD to easily set up the Network
Camera on LAN. Please refer to Software Installation on page 12 for details.
2. Enter the Static IP, Subnet mask, Default router, and Primary DNS provided by your ISP.
Subnet mask: This is used to determine if the destination is in the same subnet. The default value is
“255.255.255.0”.
Default router: This is the gateway used to forward frames to destinations in a different subnet. Invalid
router setting will fail the transmission to destinations in different subnet.
User's Manual - 35

VIVOTEK

Primary DNS: The primary domain name server that translates hostnames into IP addresses.
Secondary DNS: Secondary domain name server that backups the Primary DNS.
Primary WINS server: The primary WINS server that maintains the database of computer name and IP
address.
Secondary WINS server: The secondary WINS server that maintains the database of computer name
and IP address.
Enable UPnP presentation: Select this option to enable UPnPTM presentation for your video server so that
whenever a video server is presented to the LAN, shortcuts of connected video servers will be listed in
My Network Places. You can click the shortcut to link to the web browser. Currently, UPnPTM is supported
by Windows XP or later. Note that to utilize this feature, please make sure the UPnPTM component is
installed on your computer.

Video Server (192.168.5.151)

Enable UPnP port forwarding: To access the video server from the Internet, select this option to allow the
video server to open ports on the router automatically so that video streams can be sent out from a LAN.
To utilize of this feature, make sure that your router supports UPnPTM and it is activated.

PPPoE (Point-to-point over Ethernet)

Select this option to configure your video server to make it accessible from anywhere as long as there is
an Internet connection. Note that to utilize this feature, it requires an account provided by your ISP.
Follow the steps below to acquire your video server’s public IP address.
1. Set up the video server on the LAN.
2. Go to Home > Configuration > Application > Server Settings (please refer to Server settings on page
85) to add a new email or FTP server.
3. Go to Configuration > Application > Media Settings (please refer to Media Settings on page 88). Select
System log so that you will receive the system log in TXT file format which contains the Network
Camera’s public IP address in your email or on the FTP server.
4. Go to Configuration > Network > Network Type. Select PPPoE and enter the user name and password
provided by your ISP. Click Save to enable the setting.

5. The video server will reboot.
6. Disconnect the power to the video server; remove it from the LAN environment.
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NOTE:
► If the default ports are already used by other devices connected to the same router, the video server
will select other ports for the video server.
► If UPnP TM is not supported by your router, you will see the following message:
Error: Router does not support UPnP port forwarding.
► Steps to enable the UPnP TM user interface on your computer:
Note that you must log on to the computer as a system administrator to install the UPnP TM
components.
1. Go to Start, click Control Panel, then click Add or Remove Programs.

2. In the Add or Remove Programs dialog box, click Add/Remove Windows Components.

3. In the Windows Components Wizard dialog box, select
Networking Services and click Details.
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4. In the Networking Services dialog box, select Universal Plug and Play and click OK.

5. Click Next in the following window.

6. Click Finish. UPnP TM is enabled.
► How does UPnP TM work?
UPnP TM networking technology provides automatic IP configuration and dynamic discovery of devices
added to a network. Services and capabilities offered by networked devices, such as printing and file
sharing, are available among each other without the need for cumbersome network configuration. In
the case of video servers, you will see video server shortcuts under My Network Places.
► Enabling UPnP port forwarding allows the video server to open a secondary HTTP port on the routernot HTTP port-meaning that you have to add the secondary HTTP port number to the video server’s
public address in order to access the video server from the Internet. For example, when the HTTP
port is set to 80 and the secondary HTTP port is set to 8080, refer to the list below for the video
server’s IP address.
From the Internet
http://203.67.124.123:8080

In LAN
http://192.168.4.160 or
http://192.168.4.160:8080

► If the PPPoE settings are incorrectly configured or the Internet access is not working, restore the
video server to factory default; please refer to Restore on page 101 for details. After the video server
is reset to factory default, it will be accessible on the LAN.
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Enable IPv6

Select this option and click Save to enable IPv6 settings.
Please note that this only works if your network environment and hardware equipment support IPv6. The
browser should be Microsoft® Internet Explorer 6.5, Mozilla Firefox 3.0 or above.

When IPv6 is enabled, by default, the video server will listen to router advertisements and be assigned
with a link-local IPv6 address accordingly.
IPv6 Information: Click this button to obtain the IPv6 information as shown below.

If your IPv6 settings are successful, the IPv6 address list will be listed in the pop-up window. The IPv6
address will be displayed as follows:

Refers to Ethernet

Link-global IPv6 address/network mask
Link-local IPv6 address/network mask
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Please follow the steps below to link to an IPv6 address:
1. Open your web browser.
2. Enter the link-global or link-local IPv6 address in the address bar of your web browser.
3. The format should be:
http://[2001:0c08:2500:0002:0202:d1ff:fe04:65f4]/
IPv6 address

4. Press Enter on the keyboard or click Refresh button to refresh the webpage.
For example:

NOTE:
► If you have a Secondary HTTP port (the default value is 8080), you can also link to the webpage in
the following address format: ( Please refer to HTTP on page 46 for detailed information.)
http://[2001:0c08:2500:0002:0202:d1ff:fe04:65f4]/:8080
IPv6 address

Secondary HTTP port

► If you choose PPPoE as the Network Type, the [PPP0 address] will be displayed in the IPv6
information column as shown below.

Manually setup the IP address: Select this option to manually set up IPv6 settings if your network
environment does not have DHCPv6 server and router advertisements-enabled routers.
If you check this item, the following blanks will be displayed for you to enter the corresponding
information:
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IEEE 802.1x Advanced Mode
Enable this function if your network environment uses IEEE 802.1x, which is a port-based network
access control. The network devices, intermediary switch/access point/hub, and RADIUS server must
support and enable 802.1x settings.
The 802.1x standard is designed to enhance the security of local area networks, which provides
authentication to network devices (clients) attached to a network port (wired or wireless). If all certificates
between client and server are verified, a point-to-point connection will be enabled; if authentication fails,
access on that port will be prohibited. 802.1x utilizes an existing protocol, the Extensible Authentication
Protocol (EAP), to facilitate communication.

■ The components of a protected network with 802.1x authentication:

Supplicant
(Video Server)

Authenticator
(Network Switch)

Authentication Server
(RADIUS Server)

1. Supplicant: A client end user (video server), which requests authentication.
2. Authenticator (an access point or a switch): A “go between” which restricts unauthorized end users
from communicating with the authentication server.

3. Authentication server (usually a RADIUS server): Checks the client certificate and decides whether to
accept the end user’s access request.

■ VIVOTEK video servers support two types of EAP methods to perform authentication: EAP-PEAP and
EAP-TLS.

Please follow the steps below to enable 802.1x settings:
1. Before connecting the video server to the protected network with 802.1x, please apply a digital
certificate from a Certificate Authority (ie. MIS of your company) which can be validated by a RADIUS
server.
2. Connect the video server to a PC or notebook outside of the protected LAN. Open the configuration
page of the video server as shown below. Select EAP-PEAP or EAP-TLS as the EAP method. In the
following blanks, enter your ID and password issued by the CA, then upload related certificate(s).
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3. When all settings are complete, move the video server to the protected LAN by connecting it to an
802.1x enabled switch. The devices will then start the authentication automatically.

NOTE:
► The authentication process for 802.1x:
1. The Certificate Authority (CA) provides the required signed certificates to the video server (the
supplicant) and the RADIUS Server (the authentication server).
2. A video server requests access to the protected LAN using 802.1X via a switch (the authenticator).
The client offers its identity and client certificate, which is then forwarded by the switch to the RADIUS
Server, which uses an algorithm to authenticate the video server and returns an acceptance or
rejection back to the switch.
3. The switch also forwards the RADIUS Server’s certificate to the video server.
4. Assuming all certificates are validated, the switch then changes the video server’s state to authorized
and is allowed access to the protected network via a pre-configured port.
1

Certificate Authority
(CA)

1
Certificate

Certificate

2

4
VIVOTEK
Video Server

Network Switch

3

RADIUS Server

Protected LAN
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QoS (Quality of Service) Advanced Mode
Quality of Service refers to a resource reservation control mechanism, which guarantees a certain quality
to different services on the network. Quality of service guarantees are important if the network capacity
is insufficient, especially for real-time streaming multimedia applications. Quality can be defined as, for
instance, a maintained level of bit rate, low latency, no packet dropping, etc.
The following are the main benefits of a QoS-aware network:
■ The ability to prioritize traffic and guarantee a certain level of performance to the data flow.
■ The ability to control the amount of bandwidth each application may use, and thus provide higher
reliability and stability on the network.

Requirements for QoS

To utilize QoS in a network environment, the following requirements must be met:
■ All network switches and routers in the network must include support for QoS.
■ The network video devices used in the network must be QoS-enabled.

QoS models
CoS (the VLAN 802.1p model)

IEEE802.1p defines a QoS model at OSI Layer 2 (Data Link Layer), which is called CoS, Class of
Service. It adds a 3-bit value to the VLAN MAC header, which indicates prioritization from 0~7 (Eight
different classes of service are available). The priority is set up on the network switches, which then use
different queuing disciplines to forward the packets.
Below is the setting column for CoS. Enter the VLAN ID of your switch (0~4095) and choose the priority
for each application (0~7).

If you assign Video the highest level, the switch will handle video packets first.

NOTE:
► The web browsing may fail if the CoS setting is incorrect.
► Class of Service technologies do not guarantee a level of service in terms of bandwidth and delivery
time; they offer a "best-effort." Users can think of CoS as "coarsely-grained" traffic control and QoS
as "finely-grained" traffic control.
► Although CoS is simple to manage, it lacks scalability and does not offer end-to-end quarantees
since it is based on L2 protocol.
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QoS/DSCP (the DiffServ model)

DSCP-ECN defines QoS at Layer 3 (Network Layer). The Differentiated Services (DiffServ) model is
based on packet marking and router queuing disciplines. The marking is done by adding a field to the
IP header, called the DSCP (Differentiated Services Codepoint). This is a 6-bit field that provides 64
different class IDs. It gives an indication of how a given packet is to be forwarded, known as the Per Hop
Behavior (PHB). The PHB describes a particular service level in terms of bandwidth, queueing theory,
and dropping (discarding the packet) decisions. Routers at each network node classify packets according
to their DSCP value and give them a particular forwarding treatment; for example, how much bandwidth
to reserve for it.
Below are the setting options of DSCP (DiffServ Codepoint). Specify the DSCP value for each application
(0~63).
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HTTP Advanced Mode
To utilize HTTP authentication, make sure that your have set a password for the video server first; please
refer to Security on page 28 for details.

Authentication: Depending on your network security requirements, the video server provides two types of
security settings for an HTTP transaction: basic and digest.
If basic authentication is selected, the password is sent in plain text format and there can be potential
risks of being intercepted. If digest authentication is selected, user credentials are encrypted using MD5
algorithm and thus provide better protection against unauthorized accesses.
HTTP port / Secondary HTTP port: By default, the HTTP port is set to 80 and the secondary HTTP port is
set to 8080. They can also be assigned to another port number between 1025 and 65535. If the ports are
incorrectly assigned, the following warning messages will be displayed:

To access the video server on the LAN, both the HTTP port and secondary HTTP port can be used to
access the video server. For example, when the HTTP port is set to 80 and the secondary HTTP port is
set to 8080, refer to the list below for the video server’s IP address.
on a LAN
http://192.168.4.160 or
http://192.168.4.160:8080

Access name for channel 1~4/8: VS8401 supports 4 channels for video live viewing, as VS8801 supports
8 channels. Each channel allows you to view only one stream. The access name is used to differentiate
the streaming source. Users can go to Configuration > Audio and video > Video settings to set up the
video quality of linked streams.
When using Mozilla Firefox or Netscape to access the video server and the video mode is set to JPEG,
users will receive video comprised of continuous JPEG images. This technology, known as “server push”,
allows the video server to feed live pictures to Mozilla Firefox and Netscape.
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URL command -- http://<ip address>:<http port>/<access name for channel 1 ~ 4/8>
For example, when the Access name for stream 2 is set to video2.mjpg:
1. Launch Mozilla Firefox or Netscape.
2. Type the above URL command in the address bar. Press Enter.
3. The JPEG images will be displayed in your web browser.

http://192.168.5.151/video2.mjpg

NOTE:
► Microsoft ® Internet Explorer does not support server push technology; therefore, using http://<ip
address>:<http port>/<access name for channel 1 ~ 4/8> will fail to access the video server.

HTTPS

By default, the HTTPS port is set to 443. It can also be assigned to another port number between 1025
and 65535.

Two way audio

By default, the two way audio port is set to 5060. Also, it can also be assigned to another port number
between 1025 and 65535.
The video server supports two way audio communication so that operators can transmit and receive
audio simultaneously. By using the video server’s built-in or external microphone and an external
speaker, you can communicate with people around the video server.
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Note that as JPEG only transmits a series of JPEG images to the client, to enable the two-way audio
function, make sure the video mode is set to “MPEG-4” on the Audio and Video Settings page and the
media option is set to “Video and Audio” on the Client Settings page. Please refer to Client settings on
page 22 and Audio and video settings on page 56.

Audio transmitted to operators

America

Taiwan

Audio transmitted from operators

Audio is being transmitted to the Network Camera

Talk Button

Broadcast Mic Volume

Mute

Click
to enable audio transmission to the video server; click
to broadcast; click
to turn off the audio. To stop talking, click
again.
volume of microphone; click

to adjust the

FTP

The FTP server allows the user to save recorded video clips. You can utilize VIVOTEK's Installation
Wizard 2 to upgrade the firmware via FTP server. By default, the FTP port is set to 21. It also can be
assigned to another port number between 1025 and 65535.
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RTSP streaming

To utilize RTSP streaming authentication, make sure that you have set a password for the video server
first; please refer to Security on page 28 for details.

Authentication: Depending on your network security requirements, the video server provides three types
of security settings for streaming via RTSP protocol: disable, basic, and digest.
If basic authentication is selected, the password is sent in plain text format, but there can be potential
risks of it being intercepted. If digest authentication is selected, user credentials are encrypted using
MD5 algorithm, thus providing better protection against unauthorized access.
The availability of the RTSP streaming for the three authentication modes is listed in the following table:
Disable
Basic
Digest

Quick Time player

Real Player

O
O
O

O
O
X

Access name for channel 1 ~4/8: VS8401 supports 4 channels for video live viewing, as VS8801
supports 8 channels. Each channel allows you to view only one stream. The access name is used to
differentiate the streaming source.
If you want to use an RTSP player to access the video server, you have to set the video mode to MPEG4 and use the following RTSP URL command to request transmission of the streaming data.
rtsp://<ip address>:<rtsp port>/<access name for stream1 ~ channel 1 ~4/8>
For example, when the access name for stream 1 is set to live.sdp:
1. Launch an RTSP player.
2. Choose File > Open URL. A URL dialog box will pop up.
3. Type the above URL command in the text box.
rtsp://192.168.5.151:554/live.sdp
4. The live video will be displayed in your player as shown
below.
Video 16:38:01 2011/03/10
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RTSP port /RTP port for video, audio/ RTCP port for video, audio
■ RTSP (Real-Time Streaming Protocol) controls the delivery of streaming media. By default, the port
number is set to 554.
■ The RTP (Real-time Transport Protocol) is used to deliver video and audio data to the clients. By
default, the RTP port for video is set to 5556 and the RTP port for audio is set to 5558.
■ The RTCP (Real-time Transport Control Protocol) allows the video server to transmit the data by
monitoring the Internet traffic volume. By default, the RTCP port for video is set to 5557 and the RTCP
port for audio is set to 5559.
The ports can be changed to values between 1025 and 65535. The RTP port must be an even number
and the RTCP port is the RTP port number plus one, and thus is always an odd number. When the RTP
port changes, the RTCP port will change accordingly.
If the RTP ports are incorrectly assigned, the following warning message will be displayed:

Multicast settings channel 1 ~4/8: Click the items to display the detailed configuration information. Select
the Always multicast option to enable multicast for channel 1~4/8.

Unicast video transmission delivers a stream through point-to-point transmission; multicast, on the other
hand, sends a stream to the multicast group address and allows multiple clients to acquire the stream at
the same time by requesting a copy from the multicast group address. Therefore, enabling multicast can
effectively save Internet bandwith.
The ports can be changed to values between 1025 and 65535. The multicast RTP port must be an even
number and the multicast RTCP port number is the multicast RTP port number plus one, and thus is
always odd. When the multicast RTP port changes, the multicast RTCP port will change accordingly.
If the multicast RTP video ports are incorrectly assigned, the following warning message will be
displayed:

Multicast TTL [1~255]: The multicast TTL (Time To Live) is the value that tells the router the range a
packet can be forwarded.
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Express link
Express link is a free service provided by VIVOTEK server, which allows users to register an
domain name for a network device. One URL can only be mapped to one Mac address. This
service will check out if the host name is valid and automatically open a port on your router.
Unlike DDNS, the user has to manually check out UPnP port forwarding, Express link is more
convenient and easy to set up.
Host name assignment

Please follow the steps below to enable Express link:
1. Make sure that your router supports UPnP port forwarding and it is activated.
2. Enter a host name for the network device and click Register. If the host name has been used by
another device, a warning message will show up. If the host name is valid, it will show an error
message.

3. Click Enable to validate your setting. To access the camera, enter its express link address in a
browser’s URL field.

https://mycamera.2bthere.net
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DDNS
This section explains how to configure the dynamic domain name service for the video server.
DDNS is a service that allows your video server, especially when assigned with a dynamic IP
address, to have a fixed host and domain name.
DDNS: Dynamic domain name service

Enable DDNS: Select this option to enable the DDNS setting.
Provider: Select a DDNS provider from the provider drop-down list.
VIVOTEK offers Safe100.net, a free dynamic domain name service, to VIVOTEK customers. It is
recommended that you register Safe100.net to access VIVOTEK’s video servers from the Internet.
Additionally, we offer other DDNS providers, such as Dyndns.org(Dynamic), Dyndns.org(Custom), TZO.
com, DHS.org, CustomSafe100, dyn-interfree.it.
Note that before utilizing this function, please apply for a dynamic domain account first.

■ Safe100.net

1. In the DDNS column, select Safe100.net from the drop-down list. Click I accept after reviewing the
terms of the Service Agreement.
2. In the Register column, fill in the Host name (xxxx.safe100.net), Email, Key, and Confirm Key, and
click Register. After a host name has been successfully created, a success message will be displayed
in the DDNS Registration Result column.

[Register] Successfully Your account information has
been mailed to registered e-mail address

3. Click Copy and all the registered information will automatically be uploaded to the corresponding fields
in the DDNS column at the top of the page as seen in the picture.
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[Register] Successfully Your account information has
been mailed to registered e-mail address

4. Select Enable DDNS and click Save to enable the setting.

■ CustomSafe100

VIVOTEK offers documents to establish a CustomSafe100 DDNS server for distributors and system
integrators. You can use CustomSafe100 to register a dynamic domain name if your distributor or system
integrators offer such services.
1. In the DDNS column, select CustomSafe100 from the drop-down list.
2. In the Register column, fill in the Host name, Email, Key, and Confirm Key; then click Register. After a
host name has been successfully created, you will see a success message in the DDNS Registration
Result column.
3. Click Copy and all for the registered information will be uploaded to the corresponding fields in the
DDNS column.
4. Select Enable DDNS and click Save to enable the setting.
Forget key: Click this button if you have forgotten the key to Safe100.net or CustomSafe100. Your
account information will be sent to your email address.

Refer to the following links to apply for a dynamic domain account when selecting other DDNS
providers:

■ Dyndns.org(Dynamic) / Dyndns.org(Custom): visit http://www.dyndns.com/
■ TZO.com: visit http://www.tzo.com/
■ DHS.org: visit http://www.dhs.org/
■ dyn-interfree.it: visit http://dyn-interfree.it/
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Access list

Advanced Mode

This section explains how to control access permission by verifying the client PC’s IP address.
General settings

Maximum number of concurrent streaming connection(s) limited to: Simultaneous live viewing for 1~10
clients (including stream 1 and stream 2). The default value is 10. If you modify the value and click Save,
all current connections will be disconnected and automatically attempt to re-link (IE Explore or Quick
Time Player).
View Information: Click this button to display the connection status window showing a list of the current
connections.
For example:
Connection status
IP address

Elapsed time

192.168.1.147

12:20:34

root

61.22.15.3

00:10:09

anonymous

192.168.3.25

45:00:34

greg

Refresh

Add to Deny List

User ID

Disconnect

■ IP address: Current connections to the Video server.
■ Elapsed time: How much time the client has been at the webpage.
■ User ID: If the administrator has set a password for the webpage, the clients have to enter a user name
and password to access the live video. The user name will be displayed in the User ID column. If the
administrator allows clients to link to the webpage without a user name and password, the User ID
column will be empty.
There are some situations which allow clients access to the live video without a user name and
password:
1. The administrator does not set up a root password. For more information about how to set up a root
password and manage user accounts, please refer to Security on page 28.
2. The administrator has set up a root password, but set RTSP authentication to “disable“. For more
information about RTSP authentication, please refer to RTSP Streaming on page 48.
3. The administrator has set up a root password, but allows anonymous viewing. For more information
about Allow Anonymous Viewing, please refer to Security on page 28.
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■ Refresh: Click this button to refresh all current connections.
■ Add to deny list: You can select entries from the Connection Status list and add them to the Deny List
to deny access. Please note that those checked connections will only be disconnected temporarily
and will automatically try to re-link again (IE Explore or Quick Time Player). If you want to enable the
denied list, please check Enable access list filtering and click Save in the first column.
■ Disconnect: If you want to break off the current connections, please select them and click this
button. Please note that those checked connections will only be disconnected temporarily and will
automatically try to re-link again (IE Explore or Quick Time Player).
Enable access list filtering: Check this item and click Save if you want to enable the access list filtering
function.

Filter type

Select Allow or Deny as the filter type. If you choose Allow Type, only those clients whose IP addresses
are on the Access List below can access the Network Camera, and the others cannot access. On the
contrary, if you choose Deny Type, those clients whose IP addresses are on the Access List below will
not be allowed to access the Network Camera, and the others can access.

Filter

Then you can add a rule to the following Access List. Please note that the IPv6 access list column will not
be displayed unless you enable IPv6 on the Network page. For more information about IPv6 Settings,
please refer to page 39 for detailed information.

■ Add a rule to Allowed/Denied list: Click Add to add a rule to Allowed/Denied list.
There are three types of rules:
Single: This rule allows the user to add an IP address to the Allowed/Denied list.
For example:
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Digital I/O
This section explains how to change digital input and digital output settings.
Digital input settings
You can select High or Low to define normal status for the digital input. The video server will
report the current status.

Digital output settings
You can select Grounded or Open to define normal status for the digital output. The video
server will show the trigger is activated or not.
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Audio and video
This section explains how to cofigure the audio and video settings of the video server.
Overview
This table shows all stream settings of each channel.

Video settings

Channel: In the drop-down list, there are channel 1~4/8, select one to set video settings on it in the
column below.
Check frame rate: Check Check frame rate to display the current available frame rate status for all
frame sizes. Please refer to page 63 for details.
Video title: Enter a name that will be displayed on the title bar of the live video.
Color: Select to display color or black/white video streams.
Video orientation: Flip--vertically reflect the display of the live video; Mirror--horizontally reflect the display
of the live video. Select both options if the linked device is installed upside-down (e.g., on the ceiling) to
correct the image orientation.
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Video Title
Title and Time

Video 14:46:09 2011/1/19

Overlay title and time stamp on video and snapshot: Select this option to place the video title and time on
the video streams.
Enable time shift caching stream Advanced Mode : Check this item to enable the time shift cache
stream on the video server, which will stores video in the video server’s embedded memory for a period
of time depending on the cache memory size of each video server. This function can work seamlessly
with VIVOTEK’s ST7501 recording software. When an event occurs, the recording software can request
time shift cache stream from the camera, which allows the user to retrieve pre-event video data.
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Image settings Advanced Mode
Click Image Settings to open the Image Settings page. On this page, you can tune the White balance,
Brightness, Saturation, Contrast, and Sharpness settings for the video. Please choose the Channel first.

Image adjustment
■ Brightness: To adjust the image brightness level, please drag the slider bar to the right (+) to increase
the effect, or to the left (-) to reduce the effect.
■ Saturation: To adjust the image saturation level, please drag the slider bar to the right (+) to increase
the effect, or to the left(-) to reduce the effect.
■ Contrast: To adjust the image contrast level, please drag the slider bar to the right (+) to increase
the effect, or to the left(-) to reduce the effect.
■ Sharpness: To adjust the image sharpness level, please drag the slider bar to the right (+) to increase
the effect, or to the left(-) to reduce the effect.
■ X-offset: Adjust the image to the proper position horizontally.
■ Y-offset: Adjust the image to the proper position vertically.
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■ Enable deinterlace: Check to enable deinterlace, and choose Adaptive mode or Blend mode in the
drop-down list. Adaptive mode provides the best image quality, while Blend mode provides better
image quality (than not using the deinterlace function at all). Note that applying this function to all
channels at the same time will consume quite a lot computing power.
■ Enable edge enhancement: Check to enable edge enhancement, and drag the slider bar to adjust the
strength. Note that applying this function to all channels at the same time will consume quite a lot of
computing power.
■ Enable noise reduction: Check to enable noise reduction, and you can also choose to reduce
Gaussian noise, impulse noise, or Gaussian and impulse noise in the drop-down list. Drag the
slide bar to adjust the strength. Noted that applying this function to all channels at the same time will
consume quite a lot of computing power.
■ Restore: Click to restore the default setting.
■ Save: When finished with the setting, you can choose to apply the settings to Current channel, All
channels, Current channel and channel 2, etc. in the drop-down list. Then click Save to enable the
settings.

Privacy Mask Advanced Mode
Click Privacy Mask to open the settings page. On this page, you can block out sensitive zones to
address privacy concerns. Please choose the Channel first.
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■ To set the privacy mask windows, follow the steps below:
1. Click New to add a new window.
2. Use the mouse to size and drag-drop the window, which is recommended to be at least twice the size
of the object (height and width) you want to cover.
3. Enter a Window Name and click Save to enable the setting.
4. Select Enable privacy mask to enable this function.

NOTE:
► Up to 5 privacy mask windows can be set up on the same screen.
► If you want to delete a privacy mask window, please click on the ‘x’ mark at the upper right corner of
the window.
Video quality settings for stream 1 Advanced Mode
Click the items to display the detailed video quality settings.

■ Enable aspect ratio correction:
In the default settings, the size of the video window will change according to the layout of the live
viewing window you choose. However, the frame size may be distorted. If you check Enable aspect
ratio correction, the video window will be adjusted to the same frame size as the preview window. This
function is disabled as default.
Video 14:49:04 2011/1/20
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NOTE:
► Aspect ratio correction doesn’t support QCIF.
► When aspect ratio correction takes effect, the frame size for D1 will be adjusted to 640x480.
This video server offers real-time H.264, MPEG-4, and MJPEG compression standards (Triple Codec)
for real-time viewing.
If H.264 / MPEG-4 mode is selected, the video is streamed via RTSP protocol. There are four parameters
for you to adjust the video performance:

■ Frame size
You can set up different video resolution for different viewing devices. For example, set a smaller
frame size and lower bit rate for remote viewing on mobile phones and a larger video size and a higher
bit rate for live viewing on web browsers. Note that a larger frame size takes up more bandwidth. The
frame sizes are selectable in the following resolutions: QCIF, CIF, 4CIF, and D1.
■ Maximum frame rate
This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother video
quality. You can also select Customize and manually enter a value. The frame rate will decrease if you
select a higher resolution.
■ Intra frame period
Determine how often to plant an I frame. The shorter the duration, the more likely you will get better
video quality, but at the cost of higher network bandwidth consumption. Select the intra frame period
from the following durations: 1/4 second, 1/2 second, 1 second, 2 seconds, 3 seconds, and 4 seconds.
■ Video quality
A complex scene generally produces a larger file size, meaning that higher bandwidth will be needed
for data transmission. Therefore, if Constant bit rate is selected, the bandwidth utilization is fixed at
a selected level, resulting in mutable video quality performance. The bit rates are selectable at the
following rates: 20Kbps, 30Kbps, 40Kbps, 50Kbps, 64Kbps, 128Kbps, 256Kbps, 512Kbps, 768Kbps,
1Mbps, 2Mbps, 3Mbps, and 4Mbps. You can also select Customize and manually enter a value.
On the other hand, if Fixed quality is selected, all frames are transmitted with the same quality;
bandwidth utilization is therefore unpredictable. The video quality can be adjusted to the following
settings: Medium, Standard, Good, Detailed, and Excellent. You can also select Customize and
manually adjust the slider bar. You may adjust the slider bar to the right to have better video quality.
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If JPEG mode is selected, the video server continuously sends JPEG images to the client, producing
a moving effect similar to a filmstrip. Every single JPEG image transmitted guarantees the same
image quality, which in turn comes at the expense of variable bandwidth usage. Because the media
contents are a combination of JPEG images, no audio data is transmitted to the client. There are three
parameters provided in MJPEG mode to control the video performance:

■ Frame size
You can set up different video resolution for different viewing devices. For example, set a smaller
frame size and lower bit rate for remote viewing on mobile phones and a larger video size and a higher
bit rate for live viewing on web browsers. Note that a larger frame size takes up more bandwidth. The
frame sizes are selectable in the following resolutions: QCIF, CIF, 4CIF, and D1.
■ Maximum frame rate
This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother video
quality.
You can also select Customize and manually enter a value. The frame rate will decrease if you select
a higher resolution.
■ Video quality
The video quality can be adjusted to the following settings: Medium, Standard, Good, Detailed, and
Excellent. You can also select Customize and manually enter a value.

NOTE:
► Video quality and fixed quality refers to the compression rate, so a lower value will produce higher
quality.
► Converting high-quality video may significantly increase the CPU loading, and you may encounter
streaming disconnection or video loss while capturing a complicated scene. In the event of occurance,
we suggest you customize a lower video resolution or reduce the frame rate to obtain smooth video.
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■ Available FPS
Check Check frame rate to display the current available frame rate status (Available FPS). Available
FPS provides the information of the unused encoding capability with available frame rate in different
frame size.

The embedded Soc (System-on-Chip) has limited encoding capability, so you may set the video quality
according to the available FPS. Due to the limited encoding capability, the maximum frame rate for 4CIF
in H.264 or MPEG-4 codec can only support up to 23 FPS when all channels are applied to this setting
and being used. If the total amount of frame rate exceeds encoding capability, a warning message
"Frame rate is not guaranteed" will show up in a pop-up window. Also the frame rate that cannot be
reached for each stream will be marked in red color in the "Overview" column.

No available FPS due
to the total amount of
frame rate exceeds the
encoding capability.

the frame rate that
cannot be reached is
marked in red color.
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the frame rate that
cannot be reached is
marked in red color.

Audio settings

Mute: Select this option to disable audio transmission from the video server to all clients. Note that if
mute mode is turned on, no audio data will be transmitted even if audio transmission is enabled on the
Client Settings page. In that case, the following message is displayed:
External microphone input: Select the gain of the internal audio input according to ambient conditions.
Adjust the gain from +9 db (most sensitive) ~ -12 db (least sensitive).
G.711 Mode: G.711 also provides good sound quality and requires about 64Kbps. Select pcmu (Pulse
code Modulation μ-Law) or pcma (A-Law) mode.
Save: When finishing the setting, you can choose to apply the settings to Current channel, All
channels, Current channel and channel 2, etc. in the drop-down list. Then click Save to enable the
settings.
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Motion detection
This section explains how to configure the Video Server to enable motion detection. A total of
three motion detection windows can be configured for each channel.

Follow the steps below to enable motion detection:
1. Select Channel.

2. Click New to add a new motion detection window.
3. In the Window Name text box, enter a name for the motion detection window.
■ To move and resize the window, drag and drop your mouse on the window.
■ To delete window, click X on the upper right corner of the window.
4. Define the sensitivity to moving objects and the space ratio of all alerted pixels by moving the
Sensitivity and Percentage slider bar.
5. Click Save to enable the settings.
6. Check Enable motion detection to enable this function.

For example:
Video(TCP-AV)

The Percentage Indicator will rise or fall depending on the variation between sequential images. When
motions are detected by the Network Camera and are judged to exceed the defined threshold, the
red bar rises. Meanwhile, the motion detection window will be outlined in red. Photos or videos can be
captured instantly and configured to be sent to a remote server (Email, FTP) by utilizing this feature as a
trigger source. For more information on how to set an event, please refer to Application on page 78.
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A green bar indicates that even though motions have been detected, the event has not been triggered
because the image variations still fall under the defined threshold.

Percentage = 30%

This motion detection window will also be displayed on the Event Settings page. You can go to
Application > Event Settings > Trigger to choose it as a trigger source. Please refer to page 79 for
detailed information.

NOTE:
► How does motion detection work?
A

C

B

D

There are two motion detection parameters: Sensitivity and Percentage. In the illustration above,
frame A and frame B are two sequential images. Pixel differences between the two frames are
detected and highlighted in gray (frame C) and will be compared with the sensitivity setting. Sensitivity
is a value that expresses the sensitivity to moving objects. Higher sensitivity settings are expected to
detect slight movements while smaller sensitivity settings will neglect them. When the sensitivity is set
to 70%, the Network Camera defines the pixels in the purple areas as “alerted pixels” (frame D).
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Percentage is a value that expresses the proportion of “alerted pixels” to all pixels in the motion
detection window. In this case, 50% of pixels are identified as “alerted pixels”. When the percentage is
set to 30%, the motions are judged to exceed the defined threshold; therefore, the motion window will
be outlined in red.
For applications that require a high level of security management, it is suggested to use higher
sensitivity settings and smaller percentage values.

Camera tampering detection
This section explains how to set up camera tempering detection. With tampering detection, the
camera is capable of detecting incidents such as redirection, blocking or defocusing, or even
spray paint.

Please follow the steps below to set up the camera tampering detection function:
1. Check Enable camera tampering detection.
2. Enter the trigger duration. (10 sec. ~ 10 min.) The alarm will be triggered only when the tampering
factor (the difference between current frame and pre-saved background) exceeds the trigger threshold.
3. Set up the event source as Camera tampering detection on Application > Event settings > Trigger.
Please refer to page 79 for detailed information.
4. Click on Save to take effect.
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Camera control
This section explains how to control the Network Camera’s Pan/Tilt/Zoom operation by
connecting to a PTZ driver or scanner via RS485 interface.
RS485 settings

Disable: Select this option to disable this function.
PTZ camera: Select this option to enable PTZ operation.
To utilize this feature, please connect the Network Camera to a PTZ driver or scanner via RS485
interface first. Then you can configure the PTZ driver and RS485 port with the following settings.

Transparent HTTP Tunnel: If you want to use your own RS-485 device, you can use UART commands to
build a Transparent HTTP Tunnel. The UART commands will be sent through HTTP tunnel established
between the RS-485 device and the linked camera. For detailed application notes, please refer to URL
Commands on page 105 or http://www.vivotek.com/downloadfiles/support/faq/172_document_2.pdf.
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Preset positions

If you select DynaDome/SmartDOME, Lilin PIH-7x00, or Pelco D, Pelco P protocol, Samsung scc643
protocol protocol as the PTZ driver and click the Save button, the Preset Position button will be enabled.
Click Preset Position to open the settings page. You can also select preset positions for the camera to
patrol. A total of 20 preset positions can be configured.
Please follow the steps below to preset a position:
1. Select Channel in the drop-down list.
2. Adjust the shooting area to the desired position by using the buttons on the right. The default Home

position is set as the center position.

3. Enter a name for the preset position, which allows up to forty characters. Click Add to enable the
settings. The preset positions will be displayed under User preset locations.
4. To add additional preset positions, please repeat steps 1~2.
5. Select the preset positions and click on Save to enable the settings.
6. The positions saved will show up in Go to drop down list on the Home page. See next page
7. To remove a preset position from the list, select it and click Remove.
Functions are the same
as the Control Panel on
the home page
1
2

6

3

7
5
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■ Home location settings: You can configure the Home location by clicking on Set current position
as home. Click on Restore home position to default, and the Home position will be set as the
center position.

■ The Camera Control Panel and Preset positions will be displayed on the home page:
■ Click Go to: Select one from the drop-down list, and the Network Camera will move to the selected
preset position.
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Camera ID settings
VIVOTEK offers five PTZ drivers: DynaDome/SmartDOME, Lilin PIH-7x00, Pelco D protocol, Pelco P
protocol, and Samsung scc643 protocol. If none of the above PTZ drivers is supported by your PTZ
scanner, please select Custom camera (scanner). Please refer to the user’s manual of your PTZ
scanner to determine the Camera ID, PTZ driver, and Port settings. The Camera ID is necessary to
control multiple cameras. If you click Save to enable this function, the camera control panel will be
displayed on the main page. Please refer to the illustration on page 70.
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Patrol settings

You can select some preset positions for the Network Camera to patrol.
Please follow the steps below to set up a patrol schedule:
1. Select Channel in the drop-down list.
2. Select the preset locations on the list, and click
.
3. The selected preset locations will be displayed on the Patrol locations list.
4. Set the Dwelling time for the preset location during auto patrol.
5. If you want to delete a preset location from the Patrol locations list, select it and click Remove.
6. Select a location and click
to rearrange the patrol order.
7. Select patrol locations you want to save in the list and click Save to enable the patrol settings.
8. To implement the patrol schedule, please go to homepage and click on Patrol button.

1

4

3
2

5

7
72 - User's Manual

6

VIVOTEK

Custom Command

If Custom Camera (scanner) is selected as the PTZ driver, the Preset Position and PTZ Control
Panel on the main page will be disabled. You will need to configure command buttons to control the PTZ
scanner. Click Custom Command to open the Custom Command page to set the commands in the
Control Settings session. Please refer to your PTZ scanner user's manual to enter the commands in the
following fields. Click Save to enable the settings and click Close to exit the page.

NOTE:

►If you select DynaDome/
SmartDOME, Lilin PIH-7x00,
or Pelco D protocol as the PTZ
driver, the Control Settings
column will not be displayed.
►For all PTZ drivers, a total
of five additional command
buttons can be configured.
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►The command buttons will be displayed on the main page:
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Homepage layout

Advanced Mode

This section explains how to set up your own customized homepage layout.
Preview

This column shows the settings of your homepage layout. You can manually select the background and
font colors in Theme Options (the third column on this page). The settings will be displayed automatically
in this Preview field. The following shows the homepage using the default settings:

■ Hide Powered by VIVOTEK: If you check this item, it will be removed from the homepage.

Logo

Here you can change the logo at the top of your homepage.

Follow the steps below to upload a new logo:
1. Click Custom and the Browse field will appear.
2. Select a logo from your files.
3. Click Upload to replace the existing logo with a new one.
4. Enter a website link if necessary.
5. Click Save to enable the settings.

Customized button

Check Show manual trigger button, and it will be displayed on the Home page.
Uncheck Show manual trigger button to hide this function on the Home page.
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Theme options

Here you can change the color of your homepage layout. There are three types of preset patterns for you
to choose from. The new layout will simultaneously appear in the Preview filed. Click Save to enable the
settings.

Preset Patterns

Font Color of the Video
Title
Font Color
Background Color of the
Control Area
Font Color of the Configuration Area
Background Color of the
Configuration Area
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■ Follow the steps below to set up the customed homepage:
1. Click Custom on the left column.
2. Click the field where you want to change the color on the right column.

Color Selector

Custom
Pattern
3. The palette window will pop up as shown below.

2

3

1

4

4. Drag the slider bar and click on the left square to select a desired color.
5. The selected color will be displayed in the corresponding fields and in the Preview column.
6. Click Save to enable the settings.

User's Manual - 77

VIVOTEK

Application

Advanced Mode

This section explains how to configure the video server to respond to particular situations
(event). A typical application is that when a motion is detected, the video server sends buffered
images to an FTP server or e-mail address as notifications.
As illustrated on the right, an event can be triggered
Action
by many sources, such as motion detection or external Event Trigger
digital input devices. When an event is triggered, you ex. Motion Detection,
Digital Input,
can specify what type of action that will be performed. System Reboot
You can configure the video server to send snapshots
Media
Server
(what to send)
(where to send)
or videos to your email address or FTP site.
ex. Snapshot, Video Clips,
System Log, Digital Output

Customized script

ex. Email, FTP, HTTP Server,
Network Storage

This function allows you to upload a sample script (.xml file) to the webpage, which will save your time on
configuring the settings. Please note that there is a limited number of customized scripts you can upload;
if the current amount of customized scripts has reached the limit, an alert message will pop up. If you
need more information, please contact VIVOTEK’s technical support.

Click to upload a file

Click to modify the
script online
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Event settings

In the Event settings column, click Add to open the Event settings page. On this page, you can
arrange three elements -- Trigger, Schedule, and Action to set an event. A total of 3 event settings can be
configured.

Event name: Enter a name for the event setting.
Enable this event: Select this option to enable the event setting.
Priority: Select the relative importance of this event (High, Normal, or Low). Events with a higher priority
setting will be executed first.
Detect next event after
motion is detected.

seconds: Enter the duration in seconds to pause motion detection after a

An event is an action initiated by a user-defined trigger source; it is the causal arrangement of the
following three elements: Trigger, Event Schedule, and Action.
Trigger
This is the cause or stimulus which defines when to trigger the video server. The trigger source can be
configured to use the video server’s built-in motion detection mechanism or external digital input devices.
There are several choices of trigger sources as shown below. Select the item to display the detailed
configuration options.
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■ System boot
This option triggers the video server when the power to the video server is disconnected.
■ Video motion detection
This option makes use of the built-in motion detection mechanism as a trigger source. To enable this
function, you need to configure a Motion Detection Window first. For more information, please refer to
Motion detection on page 65 for details.

■ Camera tampering detection
This option allows the video server to trigger when the camera detects that is is being tampered with.
To enable this function, you need to configure the Camera tampering detection option first. Please
refer to page 67 for detailed information.

■ Video loss
This option triggers the video server when the transmitted media files are missing. Check to enable the
trigger source.

■ Video restore
This option triggers the video server when the camera starts to transmit video files.
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■ Periodically
This option allows the video server to trigger periodically for every other defined minute. Up to 999
minutes are allowed.

■ Digital input
This option allows the video server to use an external digital input device or sensor as a trigger source.
Depending on your application, there are many choices of digital input devices on the market which
helps to detect changes in temperature, vibration, sound, and light, etc.

■ Recording notify
This option allows the video server to trigger when the recording disk is full or when recording starts to
rewrite older data.
■ Manual trigger
This option allows user to enable event triggers manually by clicking the on/off button on the
homepage. Please configure 1 ~ 3 events before using this function.

Event Schedule
Specify the period for the event.

■ Select the days of the week.
■ Select the recording schedule in 24-hr time format.
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Action
Define the actions to be performed by the video server when a trigger is activated.

■ Trigger digital output for seconds
Check the desired DO to turn on the external digital output device when a trigger is activated. Specify
the length (seconds) of the trigger interval in the text box.
■ Delay the trigger for seconds
Check the desired DO to turn on the external digital output device when a trigger is activated. Specify
the length (seconds) of the delay for the trigger after the event has been detected.
■ Move to preset location
Select this option, the Network Camera will move to the preset location when a trigger is activated.
Please setup the preset locations first. You can setup more preset locations for each channel (Network
Camera) by clicking on Preset locations. To know more details about preset locations settings please
refer to page 69.

To set an event with recorded video or snapshots, it is necessary to configure the server and
media settings so that the video server will know what action to take (such as which server to
send the media files to) when a trigger is activated.
■ Server / Media

Click Server to configure Server settings. For more information, please refer to Server settings on
page 85.
Click Media to configure Media settings. For more information, please refer to Media settings on page
88.
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Here is an example of the Event settings page:

When completed, click Save to enable the settings and click Close to exit Event Settings page. The new
Event settings / Server settings / Media settings will appear in the event drop-down list on the Application
page.
SD Test: If you have an SD card, click the button to test the availability. Your camera will display a
message indicating a success or failure. If you want to use your SD card for local storage, please format
it before use. Please refer to page 109 for more information.
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Here is an example of the Application page with an event setting:

When the Event Status is ON, once an event is triggered by motion detection, the video server will
automatically send snapshots via e-mail.
If you want to stop the event trigger, you can click ON to turn it to OFF status or click Delete to remove
the event setting.
To remove a server setting from the list, select a server name from the drop-down list and click Delete.
Note that only when the server setting is not being applied to an event setting can it be deleted.
To remove a media setting from the list, select a media name from the drop-down list and click Delete.
Note that only when the media setting is not being applied to an event setting can it be deleted.
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Server settings

Click Server on Event Settings page to open the Server Setting page. On this page, you can specify
where the notification messages are sent when a trigger is activated. A total of 5 server settings can be
configured.
Server name: Enter a name for the server setting.
Server type
There are four choices of server types available: Email, FTP, HTTP, and Network storage. Select the item
to display the detailed configuration options. You can configure either one or all of them.
Email: Select to send the media files via email when a trigger is activated.

■ Sender email address: Enter the email address of the sender.
■ Recipient email address: Enter the email address of the recipient.
■ Server address: Enter the domain name or IP address of the email server.
■ User name: Enter the user name of the email account if necessary.
■ Password: Enter the password of the email account if necessary.
■ Server port: The default mail server port is set to 25. You can also manually set another port.
If your SMTP server requires a secure connection (SSL), check This server requires a secure
connection (SSL).
To verify if the email settings are correctly configured, click Test. The result will be shown in a pop-up
window. If successful, you will also receive an email indicating the result.

Click Save to enable the settings, then click Close to exit the page.
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FTP: Select to send the media files to an FTP server when a trigger is activated.

■ Server address: Enter the domain name or IP address of the FTP server.
■ Server port
By default, the FTP server port is set to 21. It can also be assigned to another port number between
1025 and 65535.
■ User name: Enter the login name of the FTP account.
■ Password: Enter the password of the FTP account.
■ FTP folder name
Enter the folder where the media file will be placed. If the folder name does not exist, the video server
will create one on the FTP server.
■ Passive mode
Most firewalls do not accept new connections initiated from external requests. If the FTP server
supports passive mode, select this option to enable passive mode FTP and allow data transmission to
pass through the firewall.
To verify if the FTP settings are correctly configured, click Test. The result will be shown in a pop-up
window as shown below. If successful, you will also receive a test.txt file on the FTP server.

Click Save to enable the settings, then click Close to exit the page.
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HTTP: Select to send the media files to an HTTP server when a trigger is activated.

■ URL: Enter the URL of the HTTP server.
■ User name: Enter the user name if necessary.
■ Password: Enter the password if necessary.
To verify if the HTTP settings are correctly configured, click Test. The result will be shown in a pop-up
window as below. If successful, you will receive a test.txt file on the HTTP server.

Click Save to enable the settings, then click Close to exit the page.
When completed, the new server settings will automatically be displayed on the Event Settings page.
For example:

By default, the folder is named
after the date and hour. For more
information about file destination,
please refer to page 90.
NOTE:

► By default, the folder is named after the date and hour; " %Y%M%D%H" refers to Year/
Month/Date/Hour. Your saved media files will be automatically classified in folders named
after the date and hour, if you keep the default setting. You may also create the customized
folder by any other desired name, but all media files will be saved in the same folder.
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Media settings

Click Media on the Event Settings page to open the Media Settings page. On this page, you can
specify the type of media that will be sent when a trigger is activated. A total of 5 media settings can be
configured.
Media name: Enter a name for the media setting.
Media type
There are three choices of media types available: Snapshot, Video Clip, and System log. Select the item
to display the detailed configuration options. You can configure either one or all of them.
Snapshot: Select to send snapshots when a trigger is activated.

■ Channel: Select to take snapshots from stream 1 ~ 4.
■ Send pre-event images
The video server has a buffer area; it temporarily holds data up to a certain limit. Enter a number to
decide how many images to capture before a trigger is activated. Up to 7 images can be generated.
■ Send post-event images
Enter a number to decide how many images to capture after a trigger is activated. Up to 7 images can
be generated.
For example, if both the Send pre-event images and Send post-event images are set to 7, a total of 15
images are generated after a trigger is activated.
1 pic.

2 pic.

3 pic.

4 pic.

5 pic.

6 pic.

7 pic.

8 pic.

9 pic.

10 pic.

11 pic. 10 pic.

12 pic. 13 pic.

Trigger Activation

■ File name prefix
Enter the text that will be appended to the front of the file name.
■ Add date and time suffix to the file name
Select this option to add a date/time suffix to the file name.
For example:
Snapshot_20080104_100341

File name preﬁx Date and time sufﬁx
The format is: YYYYMMDD_HHMMSS

Click Save to enable the settings, then click Close to exit the page.
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Video clip: Select to send video clips when a trigger is activated.

■ Channel: The video source. The stream source will be identical to the preset time shift caching stream.
For more information about time shift caching stream, please refer to page 57.
■ Pre-event recording
The video server has a buffer area; it temporarily holds data up to a certain limit. Enter a number to
decide the duration of recording before a trigger is activated. Up to 9 seconds can be set.
■ Maximum duration
Specify the maximum recording duration in seconds. Up to 10 seconds can be set.
For example, if pre-event recording is set to five seconds and the maximum duration is set to ten
seconds, the video server continues to record for another 4 seconds after a trigger is activated.
1 sec.

2 sec.

3 sec.

4 sec.

5 sec.

6 sec.

7 sec.

8 sec.

9 sec.

10 sec.

Trigger Activation

■ Maximum file size
Specify the maximum file size allowed.
■ File name prefix
Enter the text that will be appended to the front of the file name.
For example:
Video_20110120_100341

File name preﬁx Date and time sufﬁx
The format is: YYYYMMDD_HHMMSS

Click Save to enable the settings, then click Close to exit the page.
System log: Select to send a system log when a trigger is activated.
Click Save to enable the settings, then click Close to exit the page.
When completed, click Save to enable the settings and click Close to exit this page. The new media
settings will appear on the Event settings page.
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You can continue to select a server and media type for the event. Please go back to page 79 for detailed
information.

■ Enable customized folder: Create folders by date, time, and hour automatically: If you check this item,
the system will generate folders automatically by date.
■ View: Click this button to open a file list window. This function is only for Network Storage (NAS) and
SD/SDHC card.
If you click the View button of Network storage, a file directory window will pop up for you to view
recorded data on Network storage.
The following is an example of a file destination with video clips:
20110120
20110121

The format is: YYYYMMDD
Click to open the directory

20110122

Click to delete selected items
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Click 20110120 to open the directory:
The format is: HH (24r)
Click to open the file list for that hour

2011/01/20
2011/01/20

Click to go back to the previous
level of the directory

Click to delete
selected items
Click to delete all
recorded data

2011/01/20
2011/01/20

The format is: File name prefix + Minute (mm)
You can set up the file name prefix on Media Settings page.
Please refer to page 88 for detailed information.
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Recording > Recording settings

Advanced Mode

This section explains how to configure the recording settings for the Video Server.
Recording Settings

Insert your SD card and click here to test (VS8401 only)

NOTE:
► Please remember to format your SD card when using it for the first time. Please refer to page 109 for
detailed information.
► The SD card storage option is only available on the VS8401.

Recording Settings
Click Add to open the recording setting window. On this page, you can define the adaptive recording,
recording sources, recording schedule, and recording capacity. A total of 2 recording settings can be
configured.
■ Recording name: Enter a name for the
recording setting.
■ Enable this recording: Select this option to
enable video recording.
■ With adaptive recording:
Selecting this option will activate the frame
rate control according to alarm trigger. The
frame rate control means that when there
is a triggered alarm, the frame rate will
raise up to the value you’ve set on Stream
setting page. Please refer to page 53 for
more information.
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If you enalbe the adaptive recording and enable time-shift cache stream on Camera A, only when an
event takes place on Camera A will the server records the streaming data at the full frame rate. This
methodology only requires transferring the Intra frame data during normal operation, and full-frame-rate
videos in the occurrences of events, and thus saving users of network bandwidth and storage space.

Bandwidth
I frame ---> Full frame rate ---> I frame

Bandwidth
Activity Adaptive Streaming
for Dynamic Frame Rate Control

Continuous recording

Time

The alarm trigger includes: motion detection and DI dection. Please refer to Event settings on page 87.
■ Pre-event recording and post-event recording:
The Video Server has a buffer area; it temporarily holds data up to a certain limit. Enter a number to
decide the duration of recording before and after a trigger is activated.
■ Priority: Select the relative importance of this recording (High, Normal, or Low). Recording with a higher
priority setting will be executed first.
■ Source: Select a stream as the recording source.

NOTE:
► To enable adaptive recording, please make sure you have setup the triggering sources such as
Motion Detection, DI devices, or Manual Triggers.
► When there is no alarm trigger:
- JPEG mode: records 1 frame per second.
- H.264 mode: record one I frame only.
- MPEG-4mation.
► When the I frame period is <1s on Video settings page, it should be forced to make the I frame period
to 1s when adaptive recording is activated.
► To enable adaptive recording, please also enable time shift caching stream and select a caching
stream on page 56, Audio and Video settings.
► To enable recording notification please configure Event Settings first. Please refer to page 79.
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Please follow steps 1 to 2 below to set up a recording setting:
1. Trigger
Select a triggering condition: For example, event triggers might not make sense in a place full of human
traffic during the office hours. You may want to enable the triggering conditions during the night.

■ Schedule: The server to start recording files onto local storage or networked storage (NAS).
■ Network fail: Starts recording to the local storage (SD card) in the event of network failures.
2. Destination
You can either select an SD card or a networked storage (NAS) to store the recorded videos.

To add a NAS server, move to the Application > Event > and Add Event setting page. Please note that
only one NAS server can be configured as the recording destination.
If you have selected a NAS server as the recording destination, you should configure the following
options: Capacity, File name prefix, and Cyclic recording.
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■ Capacity: You can select either the entire storage space available or specify a reserved space. The
recording size limit must be larger than the reserved space for cyclic recording. The reserved space is
used for cyclic recording to prevent malfunctions that might occur during the transaction stage when
the video feeds are about to fill up the storage space. This value must be larger than 15 MBytes.
■ File name prefix: Enter the text that will be appended to the front of the file name.
■ Enable cyclic recording: If your check this item, when the maximum capacity is reached, the oldest file
will be overwritten by the latest ones.
If you want to enable recording notification, please refer to Event > Event Settings on page 79 for more
details.
When completed, select Enable this recording. Click Save to enable the setting and click Close to
exit. When the system begins recording, it will send the recorded files to the networked storage or SD
card. The new recording configuration will appear on the recording page as shown below. To move a
configured setting, click on the Delete button.

Below are legends on the Recording Settings page:
Name: Click to open and edit an existing configuration.
ON (Status): Click to enable or disable the recording task.
NAS or SD: Click to open the file list produced by the recording tasks. For more information about folder
naming, please refer to page 90 for details. A file list window will prompt showing previously recorded
files.

User's Manual - 95

VIVOTEK

Local storage > SD card management (for VS8401 only)
This section explains how to manage the local storage on the Network Camera. Here you can
view SD card status, and implement SD card control.
SD card staus

This column shows the status and reserved space of your SD card. Please remember to format the SD
card when using for the first time.

no SD card

SD card control

■ Enable cyclic storage: Check this item if you want to enable cyclic recording. When the maximum
capacity is reached, the oldest file will be overwritten by the latest one.
■ Enable automatic disk cleanup: Check this item and enter the number of days you wish to retain a file.
For example, if you enter “7 days”, the recorded files will be stored on the SD card for 7 days.
When all settings are completed, click Save to enable your settings.
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Local storage > Content management
This section explains how to manage the content of recorded videos on the Network Camera. Here you
can search and view the records and view the searched results.

Searching and Viewing the Records

This column allows the user to set up search criteria for recorded data. If you do not select any criteria
and click Search button, all recorded data will be listed in the Search Results cloumn.

■ File attributes: Select one or more items as your search criteria.
■ Trigger time: Manually enter the time range you want to search.
Click Search and the recorded data corresponding to the search criteria will be listed in Search Results
window.

Search Results

The following is an example of search results. There are four columns: Trigger time, Media type, Trigger
type, and Locked. Click
to sort the search results in either direction.
Numbers of entries displayed
on one page

Enter a key word to filter the
search results

Highlight an item
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■ View: Click on a search result which will highlight the selected item in purple as shown above. Click the
View button and a media window will pop up to play back the selected file.
For example:

Click to adjust the image size

■ Download: Click on a search result to highlight the selected item in purple as shown above. Then click
the Download button and a file download window will pop up for you to save the file.
■ JPEGs to AVI: This functions only applies to “JPEG“ format files such as snapshots. You can select
several snapshots from the list, then click this button. Those snapshots will be converted into an AVI
file.
■ Lock/Unlock: Select the desired search results, then click this button. The selected items will become
Locked, which will not be deleted during cyclic recoroding. You can click again to unlock the selections.
For example:

Click to switch
pages

■ Remove: Select the desired search results, then click this button to delete the files.
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System log

Advanced Mode

This section explains how to configure the video server to send the system log to the remote
server as backup.
Remote log

You can configure the video server to send the system log file to a remote server as a log backup.
Before utilizing this feature, it is suggested that the user install a log-recording tool to receive system log
messages from the video server. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog.com/
kiwi-syslog-daemon-overview/.

Follow the steps below to set up the remote log:
1. In the IP address text box, enter the IP address of the remote server.
2. In the port text box, enter the port number of the remote server.
3. When completed, select Enable remote log and click Save to enable the setting.

Current log

This column displays the system log in chronological order. The system log is stored in the video server’s
buffer area and will be overwritten when reaching a certain limit.
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View parameters

Advanced Mode

The View Parameters page lists the entire system’s parameters in alphabetical order. If you
need technical assistance, please provide the information listed on this page.
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Maintenance
This chapter explains how to restore the video server to factory default, upgrade firmware
version, etc.
Reboot

This feature allows you to reboot the video server, which takes about one minute to complete. When
completed, the live video page will be displayed in your browser. The following message will be displayed
during the reboot process.

If the connection fails after rebooting, manually enter the IP address of the video server in the address
field to resume the connection.

Restore

This feature allows you to restore the video server to factory default settings.
Network type: Select this option to retain the Network type settings (please refer to Network type on page
35).
Daylight saving time: Select this option to retain the Daylight saving time settings (please refer to System
on page 26)
Custom language: Select this option to retain the Custom Language settings.
If none of the options is selected, all settings will be restored to factory default.
The following message is displayed during the restoring process.
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Export / Upload Files Advanced Mode
This feature allows you to Export / Upload daylight saving time rules, custom language files, and setting
backup files.

Export daylight saving time configuration file: Click to set the start and end time of DST.
Follow the steps below to export:
1. In the Export files column, click Export to export the daylight saving time configuration file from the
video server.
2. A file download dialog will pop up as shown below. Click Open to review the XML file or click Save to
store the file for editing.

3. Open the file with Microsoft® Notepad and locate your time zone; set the start and end time of DST.
When completed, save the file.
In the example below, DST begins each year at 2:00 a.m. on the second Sunday in March and ends at
2:00 a.m. on the first Sunday in November.
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Upload daylight saving time rule: Click Browse… and specify the XML file to upload.
If the incorrect date and time are assigned, you will see the following warning message when uploading
the file to the video server.

The following message is displayed when attempting to upload an incorrect file format.

Export language file: Click to export language strings. VIVOTEK provides nine languages: English,
Deutsch, Español, Français, Italiano, 日本語, Português, 簡体中文, and 繁體中文.
Upload custom language file: Click Browse… and specify your own custom language file to upload.
Export setting backup file: Click to export all parameters for the device and user-defined scripts.
Upload setting backup file: Click Browse… to upload a setting backup file. Please note that the model
and firmware version of the device should be the same as the setting backup file. If you have set up a
fixed IP or other special settings for your device, it is not suggested to upload a settings backup file.

Upgrade firmware

This feature allows you to upgrade the firmware of your video server. It takes a few minutes to complete
the process.
Note: Do not power off the video server during the upgrade!
Follow the steps below to upgrade the firmware:
1. Download the latest firmware file from the VIVOTEK website. The file is in .pkg file format.
2. Click Browse… and specify the firmware file.
3. Click Upgrade. The video server starts to upgrade and will reboot automatically when the upgrade
completes.
If the upgrade is successful, you will see “Reboot system now!! This connection will close”. After that, reaccess the video server.
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The following message is displayed when the upgrade has succeeded.
Reboot system now!!
This connection will close.

The following message is displayed when you have selected an incorrect firmware file.
Starting firmware upgrade...
Do not power down the server during the upgrade.
The server will restart automatically after the upgrade is
completed.
This will take about 1 - 5 minutes.
Wrong PKG file format
Unpack fail
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Appendix

URL Commands for the Network Camera/Video Server
1. Overview
For some customers who already have their own web site or web control application, the Network
Camera/Video Server can be easily integrated through URL syntax. This section specifies the external
HTTP-based application programming interface. The HTTP-based camera interface provides the
functionality to request a single image, control camera functions (PTZ, output relay etc.), and get and set
internal parameter values. The image and CGI-requests are handled by the built-in Web server.

2. Style Convention
In URL syntax and in descriptions of CGI parameters, text within angle brackets denotes content that
is to be replaced with either a value or a string. When replacing the text string, the angle brackets
should also be replaced. An example of this is the description of the name for the server, denoted with
<servername> in the URL syntax description below, that is replaced with the string myserver in the URL
syntax example further down in the page.
URL syntax is denoted with the word "Syntax:" written in bold face followed by a box with the referenced
syntax as shown below. For example, name of the server is written as <servername> and is intended to
be replaced with the name of the actual server. This can either be a name, e.g., "mywebcam" or "thecam.
adomain.net" or the associated IP number for the server, e.g., 192.168.0.220.
Syntax:
http://<servername>/cgi-bin/viewer/video.jpg

Description of returned data is written with "Return:" in bold face followed by the returned data in a box. All data is
returned in HTTP format, i.e., each line is separated with a Carriage Return and Line Feed (CRLF) printed as \r\n.
Return:
HTTP/1.0 <HTTP code> <HTTP text>\r\n

URL syntax examples are written with "Example:" in bold face followed by a short description and a light grey box
with the example.
Example: request a single snapshot image
http://mywebserver/cgi-bin/viewer/video.jpg
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Ver. 1.0

Technical Specifications
Specifications

System Overview
External Speaker
Microphone

Pre-amplifier

Rack Mount Design

VS8801
Router

Notebook with
Web Browser
Analog
Camera

PC with
VAST

External View
VS8401

189 mm

189 mm

VIDEO 8

2

GND

485 -

485 +

GND

GND

3

24VAC

4

24VAC

GND

5

GND

6

GND

7

GND

GND

8

GND

Remove
USB

1

DI

RESET

DO

8 7 6 5 4 3 2 1

GND

Remove
SD

DC12v

ETHERNET
12V 2A

GND

AUDIO 8

49.3 mm

VIDEO 1

AUDIO 1

49.3 mm

VS8801
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Technology License Notice
MPEG-4 AAC Technology
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 AAC AUDIO PATENT LICENSE. THIS PRODUCT MAY
NOT BE DECOMPILED, REVERSE-ENGINEERED OR COPIED, EXCEPT WITH REGARD TO PC SOFTWARE,
OF WHICH YOU MAY MAKE SINGLE COPIES FOR ARCHIVAL PURPOSES. FOR MORE INFORMATION,
PLEASE REFER TO HTTP://WWW.VIALICENSING.COM.

MPEG-4 Visual Technology
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR THE
PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING VIDEO IN COMPLIANCE
WITH THE MPEG-4 VISUAL STANDARD ("MPEG-4 VIDEO") AND/OR (ii) DECODING MPEG-4 VIDEO THAT
WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/
OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED BY MPEG LA TO PROVIDE MPEG-4 VIDEO.
NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION
INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL AND COMMERCIAL USES AND LICENSING MAY
BE OBTAINED FROM MPEG LA, LLC. PLEASE REFER TO HTTP://WWW.MPEGLA.COM.

AMR-NB Standard
THIS PRODUCT IS LICENSED UNDER THE AMR-NB STANDARD PATENT LICENSE AGREEMENT. WITH
RESPECT TO THE USE OF THIS PRODUCT, THE FOLLOWING LICENSORS’ PATENTS MAY APPLY:
TELEFONAKIEBOLAGET ERICSSON AB: US PAT. 6192335; 6275798; 6029125; 6424938; 6058359. NOKIA
CORPORATION: US PAT. 5946651; 6199035. VOICEAGE CORPORATION: AT PAT. 0516621; BE PAT. 0516621;
CA PAT. 2010830; CH PAT. 0516621; DE PAT. 0516621; DK PAT. 0516621; ES PAT. 0516621; FR PAT. 0516621;
GB PAT. 0516621; GR PAT. 0516621; IT PAT. 0516621; LI PAT. 0516621; LU PAT. 0516621; NL PAT. 0516621;
SE PAT 0516621; US PAT 5444816; AT PAT. 819303/AT E 198805T1; AU PAT. 697256; BE PAT. 819303; BR PAT.
9604838-7; CA PAT. 2216315; CH PAT. 819303; CN PAT. ZL96193827.7; DE PAT. 819303/DE69611607T2; DK
PAT. 819303; ES PAT. 819303; EP PAT. 819303; FR PAT. 819303; GB PAT. 819303; IT PAT. 819303; JP PAT. APP.
8-529817; NL PAT. 819303; SE PAT. 819303; US PAT. 5664053. THE LIST MAY BE UPDATED FROM TIME TO
TIME BY LICENSORS AND A CURRENT VERSION OF WHICH IS AVAILABLE ON LICENSOR’S WEBSITE AT
HTTP://WWW.VOICEAGE.COM.
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Electromagnetic Compatibility (EMC)
FCC Statement
This device compiles with FCC Rules Part 15. Operation is subject to the following two conditions.
■ This device may not cause harmful interference, and
■ This device must accept any interference received, including interference that may cause undesired
operation.
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance
with the installation manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the user will be
required to correct the interference at his own expense.

CE Mark Warning
This is a Class A product. In a domestic environment, this product may cause radio interference, in which
case the user may be required to take adequate measures.

VCCI Warning
この装置は、クラスA情報技術装置です。この装置を家庭環境で使用すると電波妨害を引き起こすこと
があいます。この場合には使用者が適切な対策を講ずるよう要求されるこたがあります。

Liability
VIVOTEK Inc. cannot be held responsible for any technical or typographical errors and reserves the right
to make changes to the product and manuals without prior notice. VIVOTEK Inc. makes no warranty
of any kind with regard to the material contained within this document, including, but not limited to, the
implied warranties of merchantability and fitness for any particular purpose.
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